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The shortcut keys described in this Help topic refer to the U.S. keyboard layout. Keys on other 
layouts may not correspond exactly to the keys on a U.S. keyboard.
To print this topic, press TAB to select Show All, press ENTER, and then press CTRL+P.

Editing and formatting
Edit or format text

To do this Press
Display the Find and Replace task pane, with the Find option selected 
under Find or Replace. These keyboard shortcuts might not work if 
another task pane is already open.

F3 or CTRL+F or 
SHIFT+F4

Display the Find and Replace task pane, with the Replace option 
selected under Find or Replace. These keyboard shortcuts might not 
work if another task pane is already open.

CTRL+H

Check spelling. F7
Display the Research task pane to find synonyms. SHIFT+F7
If there is an insertion point in a text box, this keyboard shortcut selects 
all text in the current story (story: Text that's contained within a single 
text box or a chain of linked text boxes.). If there is no insertion point in 
any text box, it selects all the objects on a page.

CTRL+A

Make text bold. CTRL+B
Italicize text. CTRL+I
Underline text. CTRL+U
Make text small capital letters, or return small capital letters to upper 
and lower case. This keyboard shortcut is not available in Web view.

CTRL+SHIFT+K

Select the Style box on the Formatting toolbar. CTRL+SHIFT+S
Select the Font box on the Formatting toolbar. CTRL+SHIFT+F
Select the Font Size box on the Formatting toolbar. CTRL+SHIFT+P
Copy formatting. CTRL+SHIFT+C
Paste formatting. CTRL+SHIFT+V
Turn Special Characters on or off. CTRL+SHIFT+Y
Return character formatting to the current text style. CTRL+SPACEBAR
Apply or remove subscript formatting. CTRL+=
Apply or remove superscript formatting. CTRL+SHIFT+=
Increase space between letters in a word (kerning). CTRL+SHIFT+]
Decrease space between letters in a word (kerning). CTRL+SHIFT+[
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Increase font size by 1.0 point. CTRL+]
Decrease font size by 1.0 point. CTRL+[
Increase to the next size in the Font Size box. CTRL+SHIFT+>
Decrease to the next size in the Font Size box. CTRL+SHIFT+<
Set center alignment for a paragraph. CTRL+E
Set left-alignment for a paragraph. CTRL+L
Set right-alignment for a paragraph. CTRL+R
Set justified alignment for a paragraph. CTRL+J
Set distributed alignment for a paragraph. This keyboard shortcut is only
available if support for Japanese, Simplified Chinese, Traditional 
Chinese, or Korean is enabled through Microsoft Office Language 
Settings.

CTRL+SHIFT+D

Set newspaper alignment for a paragraph (East Asian languages only). CTRL+SHIFT+J
Display the Hyphenation dialog box. This keyboard shortcut is not 
available in Web view.

CTRL+SHIFT+H

Insert the current time. ALT+SHIFT+T
Insert the current date. ALT+SHIFT+D
Insert the current page number. ALT+SHIFT+P
Display the Mail and Catalog Merge task pane open to step 3 of the mail
merge procedure, if you have previously specified a data source.

CTRL+SHIFT+I

Insert a zero-width non-breaking space. CTRL+SHIFT+0 
(zero)

Set the current paragraph to single spacing. CTRL+1
Set the current paragraph to double spacing. CTRL+2
Set the current paragraph to 1.5 line spacing. CTRL+5

Copy text formats
To do this Press
Copy formatting from text. CTRL+SHIFT+C
Apply copied formatting to text. CTRL+SHIFT+V

Copy, cut, paste or delete text or objects
To do this Press
Copy the selected text or object. CTRL+C or CTRL+INSERT
Cut the selected text or object. CTRL+X or SHIFT+DELETE
Paste text or an object. CTRL+V or SHIFT+INSERT
Delete selected object. CTRL+SHIFT+X

Undo or redo an action
To do this Press
Undo the last action. CTRL+Z or 

ALT+BACKSPACE
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Redo the last action. CTRL+Y or F4
If text is selected, deselects the text, but the object that contains 
the text remains selected. 
If an object is selected, deselects the object. 
If an object within a group is selected, deselects the object but the
group remains selected. 
If text within a grouped object is selected, selects the object 
within the group. 
If the Preview Gallery is open, closes the Preview Gallery.

ESC

Nudge an object
To do this Press
Nudge a selected object up, down, left, or right. Arrow keys
If the selected object has an insertion point in its text, nudges the selected 
object up, down, left, or right.

ALT+Arrow 
keys

Zoom
To do this Press
Switch between the current view and the actual size. F9
Zoom to full page view. CTRL+SHIFT+L

Layer objects
To do this Press
Bring object to front. ALT+F6
Send object to back. ALT+SHIFT+F6

Snap objects
To do this Press
Turn Snap to Guides on or off. CTRL+SHIFT+W

Select or group objects
To do this Press
Select all objects on the page. CTRL+A
Group selected objects, or ungroup grouped objects. CTRL+SHIFT+G

Make an object transparent
To do this Press
Switch between making an object transparent or opaque (with a white fill). CTRL+T

Show or hide boundaries or guides
To do this Press
Turn Boundaries and Guides on or off. CTRL+SHIFT+O
Turn Horizontal Baseline Guides on or off. This keyboard shortcut is not 
available in Web view.

CTRL+F7

Turn Vertical Baseline Guides on or off . This keyboard shortcut is not 
available in Web view.

CTRL+SHIFT+F7

Insert an object
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To use this keyboard shortcut, you must first select the Objects Toolbar or the Insert menu.
To use this keyboard shortcut from the Objects Toolbar, first press ALT to select the menu bar, 
and then press CTRL+TAB until the Objects Toolbar is selected. Then press TAB or 
SHIFT+TAB to select the button for the type of object you want to insert in your publication.
To use this shortcut key from the Insert menu, first press ALT+I, and then use the DOWN 
ARROW key to select the menu item for the type of object you want to insert.
To do this Press
Insert an object of the type selected on the Objects Toolbar or Insert menu. CTRL+ENTER

Working with pages
Select or insert pages

If your publication is in two-page spread view, these commands will apply to the selected two-
page spread. If your publication is not in two-page spread view, these commands will apply only
to the selected page.
To do this Press
Display the Go To Page dialog box. F5 or CTRL+G
Insert a page after the selected page. CTRL+SHIFT+N
Insert duplicate page after the selected page. CTRL+SHIFT+U

Move between pages
To do this Press
Display the Go To Page dialog box. F5 or CTRL+G
Go to the next page. CTRL+PAGE DOWN
Go to the previous page. CTRL+PAGE UP
Switch between the current page and the master page. CTRL+M

Use the master page
To do this Press
Switch between the current page and the master page. CTRL+M

Creating, opening, closing, or saving a publication
To do this Press
Create a new blank publication. CTRL+N
Open a publication. CTRL+O
Close the current publication. CTRL+F4 or CTRL+W
Save the current publication. CTRL+S

Printing a publication
Use Print Preview

These keyboard shortcuts are available once you are in Print Preview (File menu, Print Preview 
command).
To do this Press
Switch between the current view and the actual 
size.

F9

Scroll up or down. UP ARROW or DOWN ARROW
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Scroll left or right . LEFT ARROW or RIGHT ARROW
Scroll up in large increments. PAGE UP or CTRL+UP ARROW
Scroll down in large increments. PAGE DOWN or CTRL+DOWN 

ARROW
Scroll left in large increments. CTRL+LEFT ARROW
Scroll right in large increments. CTRL+RIGHT ARROW
Scroll to the upper left corner of the page. HOME
Scroll to the lower right corner of the page. END
Display the Go To Page dialog box. F5 or CTRL+G
Go to the previous page. CTRL+PAGE UP
Go to the next page. CTRL+PAGE DOWN
Go to the next window. CTRL+F6
Display the Macros dialog box. ALT+F8
Display the Visual Basic editor. ALT+F11
Print the current publication. CTRL+P
Exit Print Preview. ESC

Print a publication
To do this Press
Print current publication. CTRL+P

Working with Web pages and hyperlinks
To do this Press
Insert a hyperlink (hyperlink: Colored and underlined text or a graphic that 
you click to go to a file, a location in a file, a Web page on the World Wide 
Web, or a Web page on an intranet. Hyperlinks can also go to newsgroups 
and to Gopher, Telnet, and FTP sites.) at the insertion point in a text box.

CTRL+K

Preview Web page. CTRL+SHIFT+B
Sending e-mail

After you have chosen Send This Page as Message or Send Publication as Attachment (File 
menu, Send E-mail command), you can use the following shortcut keys:
To do this Press
Send the current page or publication. ALT+S
When the insertion point is in the message header, open the Address Book. CTRL+SHIFT+B
When the insertion point is anyplace in the message header, check the names
on the To, Cc, and Bcc lines against the Address Book.

ALT+K or 
CTRL+K

When the insertion point is anyplace in the message header, open the 
Address Book in the To field.

ALT+. (period)

When the insertion point is anyplace in the message header, open the 
Address Book in the Cc field.

ALT+C

If the Bcc field is visible, open the Address Book in the Bcc field. To display ALT+B
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the Bcc field, open the Address Book for any field and insert or type a name 
in the Bcc box.
Go to the Subject field. ALT+J
Open the Microsoft Outlook Message Options dialog box. ALT+P
Create a message flag. CTRL+SHIFT+G
When the insertion point is in the message header, select the next box in the 
message header.

TAB

Select the previous field or button in the message header. SHIFT+TAB
If the insertion point is in an object that contains text, and you then choose 
the Send This Page as Message or Send Publication as Attachment command
(File menu, Send E-mail command), the insertion point moves to the To 
field in the message header. You can then press CTRL+TAB to select the 
Send button in the message header toolbar, and use the arrow keys to move 
to the other buttons. To perform the action for the selected button or 
command, press ENTER.

CTRL+TAB

Working with dialog boxes
Use dialog boxes

To do this Press
Move to the next option or option group. TAB
Move to the previous option or option group. SHIFT+TAB
Switch to the next tab in a dialog box. CTRL+TAB
Switch to the previous tab in a dialog box. CTRL+SHIFT+TAB
Move between options in an open drop-down list, 
or between options in a group of options.

Arrow keys

Perform the action assigned to the selected button; 
check or clear the selected check box.

SPACEBARFirst letter of an option in a 
selected drop-down list
  Open the list if it is closed and move to
that option in the list. 

Select an option; select or clear a check box. ALT+ the letter underlined in an option
Open a selected drop-down list. ALT+DOWN ARROW
Close a selected drop-down list; cancel a command 
and close a dialog box.

ESC

Perform the action assigned to a default button in a 
dialog box.

ENTER

Use edit boxes within dialog boxes
An edit box is a blank box in which you type or paste an entry, such as your user name or the 
path to a folder.
To do this Press
Move to the beginning of the entry. HOME
Move to the end of the entry. END
Move one character to the left or right. LEFT ARROW or RIGHT 
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ARROW
Move one word to the left. CTRL+LEFT ARROW
Move one word to the right. CTRL+RIGHT ARROW
Select or unselect one character to the left. SHIFT+LEFT ARROW
Select or unselect one character to the right. SHIFT+RIGHT ARROW
Select or unselect one word to the left. CTRL+SHIFT+LEFT ARROW
Select or unselect one word to the right. CTRL+SHIFT+RIGHT ARROW
Select from the insertion point to the beginning of the 
entry.

SHIFT+HOME

Select from the insertion point to the end of the entry. SHIFT+END
Use the Open, Save As, and Insert Picture dialog boxes

The Open, Insert Picture, and Save As dialog boxes support standard dialog box keyboard 
shortcuts. (To view standard shortcuts for dialog boxes, refer to the Use dialog boxes and Use 
edit boxes within dialog boxes sections in this Help topic.) These dialog boxes also support the 
shortcuts below.
To do this Press

Go to the previous folder . ALT+1

Up One Level button: open the folder up one level above the open folder. ALT+2

Search the Web  button: close the dialog box and open your Web search 
page.

ALT+3

Delete button: delete the selected folder or file. ALT+4

Create New Folder button: create a new subfolder in the open folder. ALT+5

Views button: switch among available folder views (List, Details, 
Properties, and Preview).

ALT+6

Tools button: show the Tools menu. ALT+7 or 
ALT+L

Open the Look in or Save in list. ALT+I
Display a shortcut menu for a selected item such as a folder or file. SHIFT+F10
Move between options or areas in the dialog box. TAB
Open and close the selected list box. F4
Refresh the files visible in the Open or Save As dialog box (File menu). F5

Working with windows, menus, toolbars, and task panes
Display and use windows

To do this Press
Switch to the next window. ALT+TAB
Switch to the previous window. ALT+SHIFT+TAB
Close the active window. CTRL+F4 or CTRL+W
Restore the size of the active window after you've CTRL+F5
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maximized it.
Move to a task pane from another pane in the program 
window (clockwise direction). You may need to press 
F6 more than once.

F6  Note  If pressing F6 doesn't 
display the task pane you want, try 
pressing ALT to place focus on the 
menu bar, and then pressing 
CTRL+TAB to move to the task pane.

Move to a pane from another pane in the program 
window (counterclockwise direction).

SHIFT+F6

When more than one window is open, switch to the 
next window.

CTRL+F6

Switch to the previous window. CTRL+SHIFT+F6
When a document window is not maximized, perform 
the Size command (on the title bar shortcut 
menu (shortcut menu: A menu that shows a list of 
commands relevant to a particular item. To display a 
shortcut menu, right-click an item or press 
SHIFT+F10.) for the window). Use the arrow keys to 
resize the window, and, when finished, press ESC.

ALT+SPACEBAR+S

Minimize the program window to an icon. ALT+SPACEBAR+N
Maximize the program window. ALT+SPACEBAR+X
Copy a picture of the screen to the Clipboard. PRINT SCREEN
Copy a picture of the selected window to the 
Clipboard.

ALT+PRINT SCREEN

Access and use menus and toolbars
To do this Press
Select the menu bar, or close an open menu and submenu at the 
same time.

F10 or ALT

When a toolbar or menu bar is selected, select the next or previous 
button or menu.

TAB or SHIFT+TAB

Select a toolbar after pressing F10 or ALT to select the menu bar. 
When a toolbar is selected, select the next or previous toolbar or 
menu bar.

CTRL+TAB or 
CTRL+SHIFT+TAB

Open the selected menu, or perform the action for the selected 
button or command.

ENTER

Display the shortcut menu for the selected item. SHIFT+F10
Display the title bar shortcut menu. ALT+SPACEBAR
When a menu or submenu is open, select the next or previous 
command.

DOWN ARROW or UP 
ARROW

Select the menu to the left or right. When a submenu is open, 
switch between the main menu and the submenu.

LEFT ARROW or RIGHT 
ARROW
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Select the first or last command on the menu or submenu. HOME or END
Close an open menu. When a submenu is open, close only the 
submenu.

ESC

When a menu is selected, display the list of commands. SHIFT+DOWN ARROW
When a shortened menu is open, display the full set of commands. CTRL+DOWN ARROW
Note  You can use the keyboard to select any menu command on the menu bar. Press ALT to 
select the menu bar. Press the letter that is underlined in the menu name that contains the 
command you want. In the menu that appears, press the letter underlined in the command name 
that you want.

Move or resize toolbars or task panes
To display a task pane, press CTRL+F1, and then, when the task pane is active, press 
CTRL+SPACEBAR to display a menu of all available task panes. Choose the one you want.
Press ALT to select the menu bar (menu bar: The horizontal bar below the title bar that contains 
the names of menus. A menu bar can be the built-in menu bar or a custom menu bar.). 
Press CTRL+TAB repeatedly to select the toolbar (toolbar: A bar with buttons and options that 
you use to carry out commands. To display a toolbar, press ALT and then SHIFT+F10.) or task 
pane you want. 
Do one of the following: 

Resize an undocked toolbar
In the toolbar, press CTRL+SPACEBAR to display the Toolbar Options menu. 
Press the LEFT ARROW key once to select the Size command, and then press ENTER. 
Use the arrow keys to resize the toolbar. Press CTRL+ the arrow keys to resize one pixel at a 
time. 

Move a toolbar
In the toolbar, press CTRL+SPACEBAR to display the Toolbar Options menu. 
Press the LEFT ARROW key twice to select the Move command, and then press ENTER. 
Use the arrow keys to position the toolbar. Press CTRL+ the arrow keys to move one pixel at a 
time. To undock the toolbar, press DOWN ARROW repeatedly. To dock the toolbar vertically 
on the left or right side, press LEFT ARROW or RIGHT ARROW respectively when the toolbar
is all the way to the left or right side. 

Resize a task pane 
In the task pane, press CTRL+SPACEBAR to display a menu of additional commands. 
Use the DOWN ARROW key to select the Size command, and then press ENTER. 
Use the arrow keys to resize the task pane. Use CTRL+ the arrow keys to move one pixel at a 
time. 

Move a task pane 
In the task pane, press CTRL+SPACEBAR to display a menu of additional commands. 
Use the DOWN ARROW key to select the Move command, and then press ENTER. 
Use the arrow keys to position the task pane. Use CTRL+ the arrow keys to move one pixel at a 
time. 
When you are finished moving or resizing, press ESC. 

Access and use task panes
To do this Press
Open or close the current task pane. CTRL+F1
Move to the open task pane from another pane in the program F6
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window. (You might need to press F6 more than once.)
When a menu or toolbar is active, move to a task pane. (You 
might need to press CTRL+TAB more than once.)

CTRL+TAB

When a task pane is active, select the next or previous option in 
the task pane.

TAB or SHIFT+TAB

When a task pane is active, displays the menu of all available task 
panes.

CTRL+SPACEBAR

Move between options in a task pane. Arrow keys
Move among choices in a selected submenu; move among certain 
options in a group of options.

DOWN ARROW or UP 
ARROW

Select the menu to the left or right, or, with a submenu visible, 
switch between the main menu and the submenu.

LEFT ARROW or RIGHT 
ARROW

Perform the action assigned to the selected button. SPACEBAR or ENTER
Moves to the top of a task pane when nothing is selected in any 
task pane option.

PAGE UP

Move to the bottom of a task pane when nothing is selected in any
task pane option.

PAGE DOWN

Scroll left in large increments. CTRL+LEFT ARROW
Scroll right in large increments. CTRL+RIGHT ARROW
Move to the top or bottom of a task pane when nothing is selected 
in any task pane option.

CTRL+HOME or 
CTRL+END

Move back to the previous Task Pane. ALT+LEFT ARROW
Move forward to the next Task Pane. ALT+RIGHT ARROW

Access and use smart tags
To do this Press
Display the menu or message for a smart tag. If more than one smart tag is 
present, switch to the next smart tag and display its menu or message.

ALT+SHIFT+F10

Select the next item in a smart tag menu. DOWN ARROW
Select the previous item in a smart tag menu. UP ARROW
Perform the action for the selected item in a smart tag menu. ENTER
Close the smart tag menu or message. ESC

Using the Help Pane and Help window
The Help Pane is a task pane that provides access to all Office Help content. As a task pane, the 
Help Pane appears as part of the active application. The Help window displays topics and other 
Help content and appears as a window next to, but separate from, the active application.
In the Help Pane
To do this Press
Display the Help Pane. F1
Switch between the Help Pane and the active application. F6
Select the next item in the Help Pane. TAB
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Select the previous item in the Help Pane. SHIFT+TAB
Perform the action for the selected item. ENTER
In a Table of Contents, select the previous and next item, 
respectively.

UP ARROW and DOWN 
ARROW

In a Table of Contents, collapse and expand the selected 
item, respectively.

LEFT ARROW and RIGHT 
ARROW

Move back to the previous Task Pane. ALT+LEFT ARROW
Move forward to the next Task Pane. ALT+RIGHT ARROW
Open the menu of all available task panes. CTRL+SPACEBAR
Close and reopen the current Task Pane. CTRL+F1
In the Help window
To do this Press
Select the next hidden text or hyperlink, or Show All or Hide All at the 
top of a topic.

TAB

Select the previous hidden text or hyperlink, or Show All or Hide All at 
the top of a topic, or the Browser View button at the top of a Microsoft 
Office Web site article.

SHIFT+TAB

Perform the action for the selected Show All, Hide All, hidden text, or 
hyperlink.

ENTER

Scroll toward the beginning or end of a Help topic. UP ARROW or 
DOWN ARROW

Scroll toward the beginning or end of a Help topic in large increments. PAGE UP or PAGE 
DOWN

Go to the beginning or end of a Help topic. HOME or END
Print the current Help topic. CTRL+P
Select the entire Help topic. CTRL+A
Copy the selected items to the Clipboard. CTRL+C
Display a shortcut menu. SHIFT+F10
Move back to the previous Help topic. ALT+LEFT 

ARROW
Move forward to the next Help topic. ALT+RIGHT 

ARROW
Close the Help window. ALT+F4
Change whether the Help window appears connected to (tiled) or 
separate from (untiled) the active application.

ALT+U

Using the Office Assistant
To show or hide the Office Assistant, press ALT+H to open the Help menu, and then press O. 

Working with the Language Bar
To do this Press
Switch between languages or keyboard layouts. Left ALT+SHIFT
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Switch microphone on or off. +V
Switch between Voice Command mode and Dictation mode. +T
Open the Correction dialog box. +C
Turn handwriting on or off. +H
Turn Japanese Input Method Editor (IME) (IME: A program that enters 
East Asian text (Traditional Chinese, Simplified Chinese, Japanese, or 
Korean) into programs by converting keystrokes into complex East Asian 
characters. The IME is treated as an alternate type of keyboard layout.) on 
101 keyboard on or off.

ALT+~

Turn Korean IME on 101 keyboard on or off. Right ALT
Turn Chinese IME on 101 keyboard on or off. CTRL+SPACEBAR
Notes
You can set the key combination for switching between languages or keyboard layouts in the 
Advanced Key Setting dialog box. To open the Advanced Key Setting dialog box, right-click the
Language bar, and then click Settings. Under Preferences, click Key Settings. 
The Windows logo key ( ) is available on the bottom row of keys on most keyboards. 

Working with macros
To do this Press
Display the Macros dialog box. ALT+F8

Working with Visual Basic
To do this Press
Display the Visual Basic editor. ALT+F11
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